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This document details the workflow for converting PDFs/scanned images to Microsoft Word format using 

ABBYY Finereader, using TransTools suite inside Microsoft Word to help with some tedious tasks. 
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I. Prerequisites 

1. Configuring ABBYY Finereader 

During initial use of Finereader make sure that it has the following settings (this will need to be done only 

once). The instructions below are for Finereader 15: 

Open Options dialogue by clicking Tools -> Options… 

 Under Image Processing tab use the settings specified below (this is required to prevent Finereader 

from detecting recognition areas automatically when the document is opened): 
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 Under OCR tab use the settings specified below (if Headers and Footers option is activated, 

Finereader can sometimes omit some text located in document headers or footers, so this option 

needs to be turned off): 

 

 

 Under Format Settings tab, DOC(X)/RTF/ODT sub-tab, use the settings specified below: 
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 In the toolbar that appears above the Text Pane on the right side, right-click and activate the settings 

specified below: 

 

 

2. Configuring Microsoft Word 

2.1. View table gridlines 

Insert a table into a new document (Insert -> Table) or select any table in an existing document, put the 

cursor inside the table and then switch to Table Tools – Layout ribbon tab. View Gridlines option must be 

activated. This will allow you to detect invisible table borders in the future. 

 

With this option activated, invisible table borders will be displayed using a thin dotted line as follows: 

 

These thin dotted borders are not printed, so do not try to remove them. The customer will not see them, but 

it will be easier for you to find and work with tables. 

2.2. View formatting marks (non-printable symbols) 

Make sure that the option to display non-printable symbols is activated (Home tab, Paragraph group). 
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When this option is turned on, Microsoft Word displays various symbols as follows: 

paragraph breaks 
 

line breaks 
 

section breaks 
 

page breaks  

column breaks  

tab characters 
 

end-of-cell  

 

soft hyphens 
 

some other symbols (space, non-breaking space, 

etc.) 

 

It should be remembered that your customer will not be able to see these symbols on printed pages and, in 

most cases, on their screen, so you should not worry about this. However, when you see these symbols on 

your screen, it will be much easier for you to perform formatting. 

2.3. View fields 

Activate visibility of (automatic) fields in order to make it easy to locate such fragments as tables of 

contents, page numbers, total pages and other automatically updated text. 

To do this, switch to File tab (Word 2010+), click Options menu, and in the Word Options dialogue under 

Advanced find the Field Shading setting and choose When Selected or Always as shown on the screenshot 

below. 
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Remember that the grey shading of fields will not be displayed on printed pages, so do not try to clear this 

shading. To make sure that you are dealing with a field and not shaded text, you can simply right-click it – if 

the context menu contains Update Field menu item, then this is an updatable field and not shaded text. 
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II. Workflow 

Here is the recommended workflow diagram. I would recommend you to follow it until you have experience 

with each step of the process, so that you can work out your own unique workflow. 
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1. Step 1 – Import document into Finereader 

After loading a new document into Finereader, before you start the recognition process, always check that 

the recognition language(s) is (are) selected properly. It is possible to select multiple languages. 

 

For scanned pages that have inadequate visual quality or if you see a lot of low-confidence characters after 

recognizing a page, you can improve image quality using Image Editor: 

 

This must be done before you mark recognition areas on the page, since all areas will be cleared from the 

page after it has been edited. Useful tools in the Image Editor include Brightness and Contrast, Deskew, 

Correct Trapezoid Distortion and Straighten Text Lines. Read Finereader Reference Documentation for 

more information (for Finereader 15, see https://help.abbyy.com/en-

us/finereader/15/user_guide/adjustimage). 

2. Step 2 – Define structure and recognize each page 

There are two objectives when you convert a PDF document for further translation: 

1. minimize the document layout issues as much as possible so that the document does not fall apart 

during text expansion or shrinking as a result of translation or editing, 

2. make the document suitable for translation inside your CAT tool 

Marking recognition areas manually helps you meet these objectives, preventing a number of conversion 

issues. 

There are four primary types of recognition areas: text, picture, background picture and table. Three of them 

– text, picture and table – are heavily used for manual area definition: 

 
Text area 

 
Picture area 

 
Table area 

To mark a specific recognition area, choose the area type on the toolbar, and then mark this area on the 

current page: 

https://help.abbyy.com/en-us/finereader/15/user_guide/adjustimage
https://help.abbyy.com/en-us/finereader/15/user_guide/adjustimage
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Different area types are used for different purposes: 

Text – one text column (standard appearance of text in a document) or several text columns similar to a 

newspaper or magazine (text from the end of one column flows into the beginning of the second column, 

etc.) 
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Regular text (one column) Multi-column text flowing from one column into 

another like in a newspaper 

Picture – regular graphical image, including an image containing many text labels 

Table 

a) simple table structure with columns and rows (including a table with invisible borders) 

 

b) complex table structure (text does not exactly look like a table, but it resembles a grid in which text in one 

column is logically linked to text in another column) 
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A table is a perfect area type. Text which is enclosed into such an area will always preserve its layout 

during translation, even if it expands too much. So, if it is difficult for you to determine what area 

type must be used, you can simply choose a table. 
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In order to define recognition areas on a page, you should use your imagination and split the page into 

horizontal bands that occupy the entire width of the page. Each band should represent a logical block of 

information. 

 

(above, the horizontal bands into which the document is split are shown in different colours) 

The horizontal bands must be defined in such a way that each band has one of the following layouts: 

1. A band that consists of a single text area 
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2. A band that consists of a single picture area 

 

3. A band that consists of a single table area 

 

4. A band that consists of several text columns located next to each other, where the text flows from one 

column to the next, i.e. after reading text at the bottom of one column, you continue reading from the 

top of the next column 
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5. A band that consists of several columns including text area(s), picture area(s) and/or table area(s). The 

difference from section 4 is the following: besides text, a column may contain image(s), table(s) or both. 

 

 

6. A band that consists of a single table area, which contains nested tables inside its cells (this layout is 

rare). 
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Examples of document recognition 

Below you will find how several typical layout examples can be split into horizontal bands and areas: 

1. Example 1 

 

This example uses the following types of bands: 2 (single picture area), 3 (complex table with one picture 

cell and merged cells), 5 (several columns with text and table areas), 1 (single text area). 

In the first table area the pump’s photo is placed inside a single cell, and Treat selected cells as picture is 

specified in the Area Properties of the cell. 
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In the two-column band shown above (under Specifications heading) several table areas are used instead of 

a single table because column widths in different parts are different. 

After you mark a table area right-click it and choose Recognize. Most of the time, Finereader splits a table 

area into cells correctly. If this is done incorrectly, you should correct the results by using the table toolbar 

which appears above the table. This toolbar allows you to divide a table into rows and columns by inserting 

or removing separators and to merge selected cells. You can also split an incorrectly merged cell using 

Split Cells command in the right-click menu. 

 

If Finereader did a very poor job, select the entire table area and press Delete key, then re-define the table 

area, select it and use the Table Toolbar to split the table into rows and columns. 

Once you make any changes to the table structure, do not forget to re-recognize the area (right-click and 

choose Recognize command), otherwise some text will not be converted. 
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2. Example 2 

 

This example uses the following types of bands: 1 (single text area), 3 (simple table area). 
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3. Example 3 

 

This example uses the following types of bands: 2 (single picture area), 1 (single text area), 2 (single picture 

area), 4 (multi-column text), 3 (table with one image cell) and 1 (single text area). 
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4. Example 4 

 

This example uses the following types of bands: 3 (table area). In this table some cells are recognized as 

images using Treat selected cells as picture option. 
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5. Example 5 

 

This example uses the following types of bands: 1 (single text area), 2 (single picture area), 1 (single text 

area), 4 (multi-column text), 1 (single text area). 

 

After the document is divided into horizontal bands and the areas are defined in all pages that require 

conversion, select these pages in the Pages Window, right-click and choose Recognize Pages. 

 

Tips: 

 To save time in pages which have a more standard layout, you can let Finereader determine areas 

automatically rather than mark them manually. To do this, select such page(s) in the Pages Window 

on the left side, right-click the page(s) and choose Recognize Pages. If recognition areas are defined 

incorrectly or it will be necessary to make a lot of changes, simply select all the areas using the 

Arrow tool, delete them with Delete key, then define the areas manually and recognize them. 
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 The text that repeats on every page (headers and footers) should be marked with areas only once, 

skipping the repetitions on other pages. However, remember that a document may contain more than 

one unique header and footer, i.e. there could be minor differences between headers and footers on 

different pages. 

 If the document contains pictures with text written on them (text labels), one of the best options is to 

recognize the entire picture as an image and then insert textboxes on top of it inside Microsoft Word 

(see Step 8 below for more details on this and other image handling options). 

 

3. Step 3 – Check for recognition issues in Finereader 

During this step, check the following in the Text window on the right side: 

 All areas have been recognized correctly. 

 All low-confidence characters are correct: 

 

 
By default, low-confidence characters will be highlighted in turquoise colour if you previously 

activated visibility of low-confidence characters in Finereader options as recommended in the 

Prerequisites section. 

 Potential spelling errors (with red underlines) are correct: 

 

 
 

You can also run Verify command to spell-check the recognized text: 

 

 Text is divided into paragraphs correctly: 

PDF page Recognized text (note that 4 paragraphs were converted into 

one) 
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This issue mostly occurs with text that does not span the entire width, for example with centred text. 

To speed up checking, pay attention to paragraph break and line break symbols at the end of lines. 

When you find a paragraph which was merged by Finereader by mistake, insert missing paragraph 

breaks or line breaks if appropriate. 

4. Step 4 – Save Document / Selected Pages 

At this step, use File > Save As > Microsoft Word Document command from the main menu (if all pages 

will be converted) or Save As > Microsoft Word Document from the right-click menu appearing after you 

select specific pages in the Pages panel on the left side (if only specific pages selected in the Pages window 

will be converted).  

Use Ctrl key when selecting pages in the Pages window to select specific pages. If there are many pages and 

some pages are not required, it is easier to delete them from Pages window using Delete… command in the 

right-click menu. 

5. Step 5 – Check text recognition errors in Microsoft Word 

Open the generated Microsoft Word document side by side with the PDF and check low-confidence 

characters (which will be highlighted in turquoise colour) and potential spelling errors. 

6. Step 6 – Automatically fix / check for formatting issues in Microsoft Word 

For this step, you will need to use Document Cleaner and Unbreaker tools available as part of TransTools 

suite. If TransTools is not yet installed on your computer, install it using the installation program 

downloaded from http://translatortools.net/downloads  

6.1. Removing incorrect paragraph breaks and line breaks in the middle of sentences.  

Often, Word documents converted with Finereader will contain paragraph breaks and line breaks in the 

middle of sentences. Unless such breaks are removed before the document is imported into your CAT tool, 

the text will be segmented incorrectly and you will have to spend time manually merging such segments, 

placing the resulting tags into correct places in the translation, and removing them from the final document. 

Incorrect breaks can be removed using Unbreaker tool. 

To run Unbreaker, click Unbreaker button on TransTools ribbon tab. 

 

http://translatortools.net/downloads
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6.2. Document reformatting and finding key issues. 

To perform initial processing of the Word document, use the Autoformat command in Document Cleaner 

tool (http://www.translatortools.net/docs/transtools/doccleaner). 

 

http://www.translatortools.net/docs/transtools/doccleaner#Autoformat
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Once you open Document Cleaner dialogue, switch to Autoformat tab: 

 

Below, you need to check the boxes for the actions that you want to apply to the current document, and also 

configure additional settings of these actions (see below). All Autoformat actions are explained below: 

 

Highlight paragraphs formatted using 

several different fonts, font sizes or font 

colours 

This action applies colour highlighting to the 

paragraphs that contain text of varying font 

size, font colour or font name, e.g. when one 

word is 9 pt. while the rest of the paragraph is 

10 pt. This issue is common during 

recognition or conversion of PDFs and 

scanned documents. When such paragraphs 

are imported into a CAT tool, they will 

contain tags due to changes in formatting. 

It is recommended to activate this action. 
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Use single paragraph line spacing (for all 

paragraphs) 

This action applies single line spacing to all 

paragraphs. 

It is recommended to activate this option to 

speed up further formatting of the document. 

 

Apply colour highlighting to all automatic 

tables of contents (to detect fragments of 

text which was converted into a table of 

contents by mistake). 

Sometimes Finereader can erroneously detect 

a certain fragment of text as a table of 

contents (TOC). Most of the time a TOC will 

not be imported into a CAT tool, so you will 

not even see such text inside your CAT tool 

and will discover the non-translated text too 

late. Also, if document fields are updated 

(which can happen in Word automatically, or 

upon your instruction), the textual contents of 

such TOC will be lost. 

This action applies colour highlighting to all 

automatic TOC’s. Normally, the very first 

TOC in a document is a “true” one and all the 

others are “false”, but there are exceptions. 

Check such text fragments manually and if 

you find a “false” TOC, convert it to text 

using Document Cleaner (see below). 

It is recommended to activate this action. 

 
Remove empty paragraphs 

This action removes empty paragraphs in the 

entire document. Later you will be able to 

insert empty paragraphs if needed or adjust 

the paragraph spacing through paragraph 

options. 

It is recommended to activate this action. 
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Remove text shading (paragraph shading 

and text shading) 

This shading can be applied to text if 

Highlight Low-confidence Characters option 

is activated in Finereader Save Options, or if 

the source document was a scan containing 

highlighter marks. This shading causes extra 

tags inside CAT tools. 

This action clears colour shading of 

paragraphs or individual characters. 

It is recommended to activate this action. 

 
Set default text spacing (scale, spacing, 

position and kerning) 

Non-standard text spacing settings are often 

applied to text when you convert scanned 

documents. This causes extra tags in CAT 

tools. 

This action applies standard text spacing 

settings that are typical of most documents. 

It is recommended to activate this action. 

 

Apply colour highlighting to tab characters 

between words 

If the original PDF file contained text justified 

on both sides, different words have different 

amount of whitespace between them. This 

causes Finereader to insert a tab character 

between words rather than a regular space. 

Inside a CAT tool, this causes incorrect 

segmentation (depending on CAT tool 

segmentation settings) or extra tags. 

This action applies colour highlighting to all 

tab characters between words. 

It is recommended to activate this action. 
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Remove soft (manual) hyphens in the 

middle of words 

This action removes invisible hyphens in the 

middle of words. Normally, Finereader inserts 

such symbols if hyphens (used to force a 

break to a new line between word syllables) 

are visible in the source document. 

It is recommended to activate this action. 

 

Left-align all tables 

Normally Finereader aligns tables in the 

centre. When this action is activated, all tables 

in the document will be left-aligned. 

This action can be activated if needed. 

 

Use “Autofit to Window” option for all 

tables 

As a rules, tables in documents created with 

Finereader have different widths. You can use 

this action if all tables in your document must 

occupy the entire width of the document’s 

working area. 

This action can be activated if needed. 

 

Use identical left and right margins for 

cells in all tables 

Documents created with Finereader can have 

very wide or very narrow table cell margins 

(i.e. the amount of space between text and the 

cell border). This action sets identical left and 

right margins for all table cells in the 

document. 

This action can be activated if needed. 
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Apply variable height for table rows if the 

row has fixed height 

As a rule, Finereader formats tables in such a 

way that table rows always keep a certain 

minimum height even if the text inside them 

shrinks. Besides, some PDF conversion 

programs can set fixed row height, so if the 

text does not fit inside such rows after 

translation, it will be visible only partially. 

This action applies the selected setting to all 

rows in all tables. The sub-option called “Set 

variable height for all rows” is best suited for 

initial processing of converted document – 

when it is selected and the action is run, all 

table rows start to adjust vertically to the 

amount of text in the cells. 

It is recommended to activate this action. Use 

“Set variable height for all rows” sub-option. 

 

Apply transparent background to all tables 

If the source document uses different cell 

background colours or various tables have 

different background colours due to the 

quality of the scanned document, it makes 

sense to apply transparent background colour 

to all tables and later adjust it manually if 

required. 

This action can be activated if needed. 

 

Use identical cell alignment in all tables 

Finereader often applies various text 

alignment settings to various cells (and often 

they are incorrect). 

To speed up document formatting it is 

sometimes advisable to apply identical text 

alignment to all cells in the document before 

changing it for a small number of cells later. 

This action can be activated if needed. 
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Apply identical border settings for all 

tables 

If this action is selected all tables will be 

reformatted to have identical borders. 

This action can be activated if needed. 

 

Use identical page margins for all sections 

in the document 

Often, when you convert a PDF document, 

different pages in the converted Word 

document may have different page margin 

settings (left, right, top and bottom margins). 

When this action is activated all the pages in 

the document will have the same page margin 

settings. 

It is recommended to activate this action. In 

most cases you will want to select Narrow 

setting in order to apply narrow margins. 

 

Minimize the number of section breaks in 

the document 

In many cases, a document obtained through 

PDF conversion will contain several sections 

which can have different headers/footers, 

page settings, etc. This causes a lot of issues. 

This action removes excessive section breaks 

if pages have the same headers/footers, etc. 

It is recommended to activate this action. 

 

Format all text using a single text column 

Finereader prefers to lay out text that has 

several visible columns by using special 

column sections (called continuous sections) 

with several text columns. This causes a large 

number of text layout issues, so it is 

recommended to reformat the text into one 

visual column (default text appearance in a 

document) and change the layout manually 

later. 

It is recommended to activate this action. 
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Use a single paper size for all pages 

In PDF documents different pages may have 

different size (A4, A3, non-standard sizes). 

When Finereader converts a page into 

Microsoft Word format, it tries to use the 

same page size as in the original PDF. This 

can cause issues during formatting. 

This action applies the same paper size (e.g., 

A4 or A3) to all sections in the document. 

It is recommended to activate this action. Use 

A4 setting in most cases. 

 

Convert page breaks and/or column breaks 

to regular paragraph breaks 

Converted documents often contain multiple 

page breaks or column breaks which make 

formatting more difficult. 

This action replaces page breaks and column 

breaks with regular paragraph breaks. 

It is recommended to activate this action. It is 

better to activate both sub-options – Page 

breaks and Column breaks. 

 
Remove frames around text, tables and 

images 

Very often Finereader places certain 

fragments of text (especially tables and 

images) inside frames. The downside of 

frames is that the contents of the frame cannot 

wrap to the next page if they do not fit on one 

page. Also, frames make it more difficult to 

format the document. 

This action removes frames, leaving the 

contents of the frames in the original place. 

It is recommended to activate this action. 
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Format empty invisible (1-point size) 

paragraphs using default font size 

Occasionally Finereader and similar programs 

insert very small empty paragraphs (font size 

– 1 pt) into a Word document in order to 

create vertical spacing between objects. As a 

rule, such empty paragraphs are invisible and 

can make further document formatting more 

complicated. 

When this action is activated, standard font 

size (usually 8 pt) will be applied to such 

empty paragraphs. 

It is recommended to activate this action. 

 

Make all images inline 

Oftentimes, documents obtained with the help 

of Finereader and similar programs contain 

images with text flowing around them. In 

most cases such images are difficult to work 

with. This action makes all document images 

inline, i.e. the text does not flow around them. 

It is recommended to activate this action. 

 

Clearly identify textboxes 

Textboxes are a real nightmare for documents 

which were converted from PDFs. In real life 

textboxes are used when specific text must 

float above images and other text, but 

Finereader often uses textboxes in order to 

enforce more simple text layouts. From 

translation perspective textboxes are a big 

complication because they tend to shift their 

position away from the original location or 

expand as a result of translation, sometimes 

with unpredictable results. 

This action marks textboxes using colour 

highlighting or textbox background colour. 

It is recommended to activate this action. Use 

the settings shown on the left: select Text 

Highlight Color in the first list (to apply 

colour highlighting to the text inside the 

textbox) and then choose the highlight colour 

that is not used by the other actions. 
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In order to process your first document you can set the checkboxes and settings as specified in the above 

table. Once the settings have been adjusted, you may want to save them in a profile in order to avoid this in 

the future. To create a new profile select [New profile…] in the list at the bottom of Document Cleaner 

dialogue, enter the profile name and then click Save button. The current settings of all Document Cleaner 

commands will be saved to the selected profile. In the future, when you want to run Autoformat command, 

simply select this profile from the list and click Load to apply the settings from the profile. 

 

When all the appropriate actions have been activated and configured, click Run selected commands button. 

All selected actions will be executed for the current document. 

Now go through the entire document and check it: 

 Check the paragraphs that are fully highlighted in colour. Such paragraphs contain text formatted in 

different font, font size or font colour. [Note: if you move text out of a textbox using the appropriate 

Quick Action from inside Document Cleaner, the moved text will also be highlighted, even though it 

may contain the same font, font size and colour]. 

 
When the paragraph contains text formatted with several different fonts or fonts sizes, you will be 

able to tell this by the empty font or font size field on the Home tab (see screenshot below): 

 
As for font colour differences, it is often difficult to notice them with a naked eye, so it is simpler to 

select the entire paragraph and select Automatic font colour for it. 

 

In some rare cases these differences are valid, but most of the time this is a Finereader’s mistake. In 

the specific example shown above, we have encountered a common issue: Finereader merged two 

different paragraphs that had different font size, producing a single paragraph. Therefore, you must 

insert a paragraph break before “3.6” to separate these paragraphs.  

In other cases you should assign an identical font, font size and font colour to the whole paragraph.  

 Find textboxes (the text inside them will be highlighted with the colour you specified in Autoformat 

settings): 
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In most cases the contents of the textbox should be relocated into the body of the document and the 

textbox should then be removed. To do this, put the cursor inside the textbox and use a special 

command included in Document Cleaner: 

 
When you do this, the text will be moved from inside the textbox and placed next to the paragraph to 

which the textbox was attached (“anchored”), and then the textbox will be removed. The moved text 

will be highlighted in yellow. The text may be moved to the wrong location, so check with the PDF 

and move it into the appropriate location if necessary. 
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 If the document contains tab characters which are highlighted in colour (see example below), check 

whether a regular space must be used instead of a tab character. 

 
In this example regular spaces must be used between words instead of tab characters. 

Manually replace the tab characters with spaces. 

If you want to replace all highlighted tab characters with spaces in the entire document, you can 

speed up the operation using a special command included in Document Cleaner. 

 

(before you use the command, double-check that all the tabs that are highlighted in colour must 

indeed be replaced with spaces) 
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 Check whether the document contains automatic tables of contents which look like normal text (they 

will have colour highlighting in accordance with the Autoformat settings that you used). 

If you found it, you can quickly convert it to regular text using a special command included in 

Document Cleaner. To do this, place the cursor in any place within such field and run the following 

command: 

 

 

This completes the initial formatting step. 

Clear colour highlighting in the entire document (select the entire text using Ctrl+A key combination and 

use the Text Highlight Color tool: 
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You can also clear colour highlighting using Clear Highlight tool from TransTools ribbon: 

 

 

6.3. Removing redundant tags. 

To remove redundant tags caused by invisible formatting differences, run Document Cleaner tool and click 

Clean Tags button under Tag Cleaner tab. You may leave default settings. 

 

Here is the detailed information about Tag Cleaner options and the recommended settings: 

 
Set default text spacing (scale, spacing, 

position and kerning) 

Non-standard text spacing settings are often 

applied to text when you convert scanned 

documents. This causes extra tags in CAT tools. 

This option applies standard text spacing 

settings that are typical of most documents. 
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It is recommended to activate this option. 

 
Remove text shading (paragraph shading and 

text shading) 

Shading can be applied to text if Highlight Low-

confidence Characters option is activated in 

Finereader Save Options, or if the source 

document was a scan containing highlighter 

marks. Such shading causes extra tags inside 

CAT tools. 

This option clears colour shading of paragraphs 

or individual characters. 

It is recommended to activate this option. 

 
Remove manual (soft) hyphens 

This option removes invisible hyphens in the 

middle of words. Normally, Finereader inserts 

such symbols if hyphens (used to force a break 

to a new line between word syllables) are visible 

in the source document. 

It is recommended to activate this option. 

 Change font colour from Black to Automatic 

Automatic and Black are two different colours, 

so every change between such colours is 

converted to tags by CAT tools. These two 

colours may occur together in documents 

converted by PDF converters or assembled from 

various sources. 

Use this option to change the 'black' colour to 

'automatic'. 

It is recommended to activate this option. 

 

Remove excessive bookmarks 

Finereader inserts bookmarks in converted 

Word documents to enable Table of Contents 

functionality and for some other reasons. 

Bookmarks cause tags inside your CAT tool so 

they should be removed unless they are 

necessary. 

This option removes certain bookmarks 

depending on the following sub-options: 

Not referenced from inside document option 
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removes bookmarks which are not referenced 

from any hyperlinks or fields (including TOC 

hyperlinks). 

TOC bookmarks option removes bookmarks 

which are created by Microsoft Word when a 

TOC is generated in order to enable jumping 

from the TOC to specific sections of the 

document. In most cases, TOC bookmarks can 

be removed before translation and re-created 

after translation by updating the TOC. 

For documents converted with Finereader, it is 

recommended to activate ‘Remove excessive 

bookmarks’ + ‘Not referenced from inside 

document’ options. 

 
Remove text highlighting 

When text highlighting is applied to parts of a 

paragraph (as opposed to whole paragraphs), it 

is usually imported into CAT tools as tags. This 

option removes all text highlighting from text. 

This option can be activated if necessary. 

 
Remove character styles, leave direct 

formatting only 

Most documents produced by Finereader will 

contain character styles on top of paragraph 

styles, causing tags in CAT tools. If you use this 

option, the command will strip character styles, 

leaving equivalent direct formatting untouched. 

It is recommended to activate this option. 

 Accept tracked changes and switch off 

change tracking 

Documents produced by Finereader will not 

have tracked changes, however tracked 

revisions in general may cause excessive tags in 

some CAT tools. It is recommended to accept 

them before translating the document. When 

you use this option, the command will accept all 

tracked changes and turn off change tracking. 

This option can be activated if necessary. 

 
Normalize font colour in each paragraph 

When processing PDFs, especially scanned 
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PDFs, a single paragraph may contain several 

different text colours which are similar. This 

causes tags in CAT tools. When you use this 

option, Tag Cleaner will apply the first text 

colour to other parts of the paragraph if these 

colours are very similar. 

This option can be activated if necessary, e.g. if 

you see a warning about remaining tags after the 

first run of Tag Cleaner. 

 

Normalize font size in each paragraph 

When processing PDFs, especially scanned 

PDFs, a single paragraph may contain several 

different font sizes. This causes tags to appear 

when the document is imported into a CAT tool. 

When you use this option, the command will 

apply the first font size to the rest of the 

paragraph (subject to the sub-options). 

This option can be activated if necessary, e.g. if 

you see a warning about remaining tags after the 

first run of Tag Cleaner. 

 
Normalize font in each paragraph 

When processing PDFs, a single paragraph may 

contain several different fonts (e.g., Calibri 

alongside Arial). This causes tags to appear 

when the document is imported into a CAT tool. 

When you use this option, Tag Cleaner will 

apply the first font face to the rest of the 

paragraph (except for symbol fonts). 

This option can be activated if necessary, e.g. if 

you see a warning about remaining tags after the 

first run of Tag Cleaner. 

 
Replace special symbols with regular 

characters where appropriate 

Some documents may contain special symbols 

from Symbol, Wingdings and some other 

symbol fonts. CAT tools display these symbols 

as tags. When you use this option, certain 

symbols which are also present in standard fonts 

are replaced with regular text, reducing the 

number of tags. 

This option can be activated if necessary. 
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When Tag Cleaner command completes, you may see a warning that the command found paragraphs whose 

text is formatted using different font, font size or colour (such differences will also cause extra tags inside 

your CAT tool): 

 

This means that you should run Autoformat command again (see Step 6.2), activating Highlight paragraphs 

formatted using several different fonts, font sizes or font colors option only. Then reformat such paragraphs. 

You can also follow the advice given in the warning and activate additional Tag Cleaner options (Normalize 

font color, Normalize font size and Normalize font) and then re-run Tag Cleaner in order to “normalize” the 

formatting of such paragraphs automatically. 

 

7. Step 7 – Manually format Word document 

During this step, do the following: 

 Put text into headers/footers, inserting section breaks and unlinking headers/footers from previous 

sections if necessary. 

 Merge multi-page tables. 

 Correct numbering in automatically numbered lists (if any automatic numbering is inconsistent with 

the PDF). 

 Check document for merged paragraphs and split them if appropriate (see notes below). 

 Put text back into columns where appropriate. 

 Check bold, italic, underline formatting of paragraphs and individual phrases/words. 

 Check text colours and background colours. 
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 Adjust spacing between paragraphs. 

 Adjust paragraph and list indentation, tab positions, alignment (left/centre/right/justified). 

 

Note 1: Checking document for merged paragraphs.  

Occasionally, Finereader combines several paragraphs into a single paragraph. 

Example: 

 

Usually such merged paragraphs will be highlighted in yellow when you run Autoformat option called 

“Highlight paragraphs formatted using several different fonts, font sizes or font colours” (see above). 

To identify such text more easily, you can also select the entire text within the document and set paragraph’s 

right indentation to 0. 

Pay particular attention to bulleted and numbered lists, since Finereader tends to combine several list items 

into one. 

 

Note 2: Finding all text fragments which must be moved into headers/footers, and moving them. 

Move the text that corresponds to original document’s headers and footers (repeated at top/bottom of pages) 

into the header and footer of the appropriate section. 

Once the text has been moved into the headers or footers, find numbers that denote the current page number 

and total number of pages and replace them with updatable fields using Quick Parts – Field under Insert tab. 

Use Page field to insert a page number field and NumPages field to insert the total number of pages. Use 

SectionPages field to insert the number of pages in the current section. 

 

Note 3: Merging multi-page tables. 

Sometimes, a table in the original PDF may span several pages, and such table will be split into several 

tables in the generated Word document. Merge these tables by removing the paragraph breaks that separate 

them.  

If the top rows of the table were repeated on each page, you will need to remove such rows in all tables 

except the first one, and then activate the option called “Repeat as header row at the top of each page” in 

Table Properties for the first row(s) of the table. 

If the column borders within the combined table are not aligned (see example below), you will need to 

adjust them: 
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You can achieve this using the special Table Aligner tool included in Document Cleaner. Select the entire 

combined table and run Table Aligner: 

 

 

Note 4: Putting text back into columns. 

If specific text must be laid out in several columns flowing into each other, select such text and then choose 

the appropriate number of columns from Columns list under Page Layout tab. 
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This will convert the text into multi-column text and place continuous section breaks before and after the 

text: 

 

 

Note 5: Removing colour highlights 

Clear colour highlighting if it is present by using Remove Highlight command (TransTools tab, 

Miscellaneous group) or using Text Highlight Color tool (Home tab, Font group). 

 

8. Step 8 – Handle images containing text 

There are several different ways to translate images that contain text on them: 

Option 1. Overlaying textboxes above image in Microsoft Word 

Create a single picture area around the image containing text, without creating text areas for the text 

on the image. This will create an image in Microsoft Word. The text written on the image will not be 

editable.  
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In ABBYY Finereader: 

 

In Microsoft Word: 

 

Then, overlay textboxes on top of each image, obscuring the text that is written on the image: 
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To do this, place the cursor right before the image and insert a textbox: 

 
 

Specify an invisible border and narrow margins for the textbox: 
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Word 2007, Word 2010, Word 2013, Word 

2016, Office 365, DOCX format with 

compatibility mode switched off 

Word 2003, Word 2000, other Word 

versions with compatibility mode switched 

on 

 

 

  

Once the first textbox has been inserted and its formatting (including font properties) has been 

specified, make copies of this textbox to create new text labels for this and other images. 
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Pros: the text will be imported into the CAT tool and translated together with the document, and 

only minimum formatting will be required after translation.  

Cons: Extra DTP before translation begins, some post-formatting after the document is translated to 

fit the text. 

Option 2. Overlay text areas above picture area in Finereader 

In Finereader, place text areas above picture area. This text will be converted to textboxes floating 

above the image. 

In ABBYY Finereader: 
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In Microsoft Word: 

 

However, in this case Finereader will remove the text from the image in the generated Word 

document, so there will be no text written on the image itself. At the same time, the text will be 

placed inside a frame, and the frame will be fixed to the top of the page and it will be difficult to 

work with this image if it is placed in the translated document. Therefore, translate the individual text 

labels, resizing the frames around them if necessary and making sure that they are positioned 

correctly. Once all such images are translated, save the Word document as a PDF file, open the PDF 

file in Adobe Reader, zoom in so that the image occupies the entire screen, click Edit > Take a 

Snapshot, and then select the area around the image to copy the image to the clipboard: 

 

After that paste the image in the translated Word document. 

Note: if you have to use Autoformat command on a Word document that contains images prepared 

as described above, make sure that you untick “Do not put text / tables / images inside frames” 

option, as this option will cause the text labels to be re-formatted. 

 

Pros: the text will be imported into the CAT tool and translated together with the document, and 

only minimum formatting will be required after translation.  

Cons:  

1) The translated Word document will contain non-editable text over the image. 

2) This approach cannot be used if the text overlaps other image contents, since Finereader removes 

the image contents under the text areas. 

3) Extra care must be taken to position text above image, using the source PDF as reference, since 

no text will remain on the image. 

4) Extra DTP before translation begins, some post-formatting after the document is translated to fit 

the text. 
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Option 3. Translate text in TransPDF or PDF editor 

If the text on the image can be selected within your PDF viewer, you can use Infix Editor or 

TransPDF web service to translate the pages that contain such images. Then open the “translated” 

PDF in Adobe Reader and copy large-scale screenshot to Microsoft Word using Take A Snapshot 

command (Edit – Take a snapshot menu). This approach does not work if the text is “embedded” 

into the image, i.e. it cannot be selected in your PDF viewer. 

Pros: Ability to translate rotated text, compact text, etc. 

Cons:  

1) The translated Word document will contain non-editable text over the image. 

2) A single text label in a PDF document may be split into several textboxes, so it may be 

cumbersome to edit and format the text. 

3) Not all images in an editable PDF document may contain editable text. 

Option 4. Translate images using image editor 

Translate images using Paint.net (see http://www.translatortools.net/blog/articles-and-

workflows/164-article-translating-images-paint-net) or another image editing program. This 

approach takes longer, but it allows you to translate very compact text or text written against 

complex backgrounds (e.g. gradient background). 

Pros: better control of the text, ability to edit text that has complex backgrounds. Some image editors 

like Photoshop have numerous options to control text formatting and layout. 

Cons:  

1) If typos or errors are found in the translation, the image will need to be modified and re-inserted 

into the document. 

2) To translate the text, you must put it in a separate document or inside a dual-column table below 

the image in the source document. 

3) More time required than the textbox workflows described above. 

4) Several tools are required to perform this operation. 

 

9. Step 9 – Translate 

 Before importing the document into the CAT tool, write down all the things that may need attention 

after the translated document is exported from the CAT tool, so that you can use this list to expedite 

checking of the translated document and also import the document into the CAT tool correctly: 

o Presence of textboxes: they will need to be checked for partially invisible text and 

resized/reformatted if necessary. 

o Presence of table(s) of contents: they will need to be updated in the final document. 

http://www.translatortools.net/blog/articles-and-workflows/164-article-translating-images-paint-net
http://www.translatortools.net/blog/articles-and-workflows/164-article-translating-images-paint-net
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o Presence of tab characters which are used to align text into columns: you may need to alter 

the segmentation settings of your CAT tool during importing so that the CAT tool breaks the 

text into separate segments at these tab characters. 

 Import the document into your CAT tool to check for excessive tags and incorrect segmentation. If 

required, correct these issues in the source document and re-import it. 

 

10. Step 10 – Pre-flight check 

At this step, do the following: 

1. Visually check the document against the PDF. 

2. Update tables of contents and perform other actions you normally do in final Word documents before 

delivery. 

3. Check whether all text fits inside textboxes (they will usually be images).  

 

You can use Document Cleaner’s Autoformat command as explained above to highlight the contents 

of all textboxes in order to make them more prominent, but make sure that you run only “Clearly 

identify textboxes” command as follows: 

 

 

4. Check the document for table rows that have fixed height, preventing the text from being fully 

visible inside such rows. 
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To find such rows easily, use the following tool available in Document Cleaner: 

 

Here is what you need to do: 

- Select Other Tools tab. 

- Select Row Height Resizer tab below. 

- Select “Decide which rows need to be formatted as variable height rows” option. This will search 

the document for all fixed-height rows. 

- Click Uncheck All button. 

- Go through the list, selecting each entry. You will see the corresponding row selected inside the 

document window. If you think this row needs to be converted to a variable-height row, tick the 

checkbox. 

- When you are finished reviewing, click Apply Variable Height Setting button to re-format the 

ticked rows. 
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III. Tips: Preparing accurate quotes for PDF translation 

Your quote will include two things: the word count and the additional effort for conversion and preparation 

before and after translation. Here is a suggested workflow for creating quotes for PDF translation: 

1) Begin by checking the type of PDF document. 

First, you need to determine the type of the PDF document. There are three types of PDF documents: 

- Text PDFs. These files contain text that you can select and copy to another application. How can you 

recognize a text PDF? First, you can select individual words. And second, when you zoom in on the 

text, you can see smooth outlines of characters. 

 

- Image PDFs. These files are created by photocopying paper documents. How can you recognize an 

image PDF? First, when you zoom in on the text, you will see jagged text outlines, uneven lines of text 

and visual distortions. And second, you cannot select individual words. 
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- Searchable image PDFs. These files are created by processing image PDFs with optical character 

recognition (OCR) software that automatically recognizes the text and inserts the recognized text behind 

the page images. This way, it is possible to search for text in such PDFs and even select the text, but the 

text may contain recognition errors. How can you recognize such PDFs? They look like image PDFs but 

it is possible to select individual words. 

 

To make it easier to determine if the PDF is an image PDF or searchable image PDF, you can use a free 

application called PDF Image Extractor 

(http://www.translatortools.net/products/miscellaneous/pdfimageextract). This program extracts all the 

images from the PDF into a separate folder. You can then view the extracted images. If you find that every 

image is a photocopied page, the PDF is clearly an image PDF or a searchable image PDF. 

2) Open the PDF in Finereader’s OCR Editor 

 

3) Recognize all pages automatically 

Select all pages, right-click and choose Recognize Pages command. Finereader will automatically 

determine the structure of each page and recognize the text. 

4) Check for PDFs with very simple structure 

If the layout of the PDF is very simple – a number of paragraphs following each other, with a few 

simple tables and images, – then you can usually convert it to a Word document straight away and 

translate it.  

At the quoting stage, it is recommended to perform pseudo-translation or machine translation to 

understand whether you will need to do any additional work when the job is approved by your client, 

such as manual recognition inside Finereader or special formatting of the Word document. 

http://www.translatortools.net/products/miscellaneous/pdfimageextract
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5) Analyze additional effort in Finereader for all other PDFs 

 You will need to fix recognition mistakes if this is a poorly scanned PDF. So count the rough 

number of such mistakes in the entire document. 

 

 You will need to translate text over images, so count the number of text labels in all images. 

 

 Estimate the amount of effort required to take care of various layout and formatting aspects, both 

during conversion inside Finereader and during preparation inside Word. The table below is a a 

sample estimate that you can use as a template for estimation. Under each aspect, you can see a 

description that explains why this aspect is important: 

Aspect Count Estimated time 

(Scan) Poor recognition quality – rough 

number of mistakes 

If the PDF contains scanned pages with low scan 

quality, Finereader may produce text recognition 

mistakes which will need to be fixed before saving 

the document. You need to perform recognition of all 

pages and check how many recognition mistakes 

(roughly) will need to be corrected inside Finereader. 

Approx. 300 1.5 hours 

(Images) Text labels over images 

If the PDF contains images with text on them, you 

will need to prepare the text in images for translation 

using the approaches explained in Step 8 above. 

15 1 hour 
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Aspect Count Estimated time 

(Structure) Changes in page parameters 

(size, orientation) 

If the size or orientation of different pages in the PDF 

are not the same, you will need to create different 

sections and adjust their page properties. 

2 15 minutes 

(Structure) Changes in header/footer 

compared to previous page 

In case different pages of the PDF have different 

headers and footers, you will need to create different 

sections, configure headers/footers, and modify 

headers/footers so that they are identical to PDF. 

5 30 minutes 

(Structure) Table of contents 

If the PDF contains a table of contents, Finereader 

will generate a table of contents, but it may be 

impossible to update such table of contents after 

translation. You need to check which headings are 

used to assemble the table of contents, and possibly 

adjust their styles, and then modify the table of 

contents appropriately. 

– 15 minutes 

(Formatting) Checking and fixing list 

numbering 

If the PDF contains numbered lists, the numbered lists 

in the Word document may be incorrect, e.g. some 

paragraphs may be formatted as normal paragraphs 

and not as list paragraphs. List numbering in complex 

multi-level lists may also be incorrect. 

– 5 minutes 

(Formatting) Checking bold, italic, 

underline, text colors applied to individual 

words and phrases. 

If the PDF contains bold, italic, underline, or specific 

colours applied to individual words and phrases (and 

not to the entire paragraph), you will need to check 

that the Word document contains the same formatting. 

This is especially relevant for conversions made with 

Finereader 12. 

– 10 minutes 

(Formatting) Paragraph formatting 

inconsistencies 

If some paragraphs have distinct alignment, 

indentation, before/after spacing and line spacing 

compared to other paragraphs, you will need to make 

sure that the Word document is adjusted accordingly. 

– 20 minutes 

(Formatting) Background colors 

The PDF may have background colors applied to 

paragraphs or tables and table cells, so you will need 

to apply the same formatting in Word. 

– 10 minutes 
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Aspect Count Estimated time 

(General) Manual conversion in Finereader 

You will need to take some time to mark recognition 

areas in Finereader. This will usually depend on the 

number of pages and complexity of page layout. 

– 30 minutes 

(General) Automated checks in Word 

You will need to take some time to process the Word 

document with Document Cleaner and Unbreaker 

tools, check all issues found by Document Cleaner’s 

Autoformat command and make appropriate 

adjustments. 

– 10 minutes 

Total  4:55 

 

6) Produce word count 

Once you have estimated the time for all the additional effort, find the images that contain text on them 

and change such image areas to text areas: 
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Then select all pages and perform Recognize Pages command so that all the text from those images gets 

into the Word document: 

 

Finally save the Word document and prepare the word count in your CAT tool. 
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IV. Extra tools for Word document formatting before and after translation 

in CAT tools 

1. Removing excessive spaces in Word documents 

Removal of excessive spaces from a Word document before CAT tool import improves TM leverage. Also, 

sometimes excessive spaces are used to align text into visual columns, i.e. they are used instead of tab 

characters. 

To find and replace excessive spaces you can use Remove Excessive Spaces tool in TransTools: 

 

 

This tool works as a Find & Replace dialogue – when you click Find Next button, you locate the next 

sequence of spaces, and you can replace it with a single space, tab character, line break, paragraph break or 

nothing (no text) by clicking Replace button. Replace All button performs replacement automatically until it 

finds a sequence of 5 (default) or more spaces (this setting is configurable). 

Remove spaces at start/end of paragraphs or lines option allows you to remove spaces at the beginning and 

end of paragraphs or lines. 

The last two options make it possible to remove spaces before and after punctuation signs. 

2. Finding and correcting punctuation issues, common mistakes, common text 

recognition issues 

Documents converted from PDF files may contain the following: 

 Common recognition mistakes, e.g. specific letter combinations are often recognized incorrectly. 
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 Common spelling errors. 

 Common typos. 

 Punctuation errors. 

You can find and correct all these issues using a special tool called Multiple Find & Replace. It is a 

powerful substitute for Word’s Find / Replace dialogue and Navigation pane which allows you to search for 

multiple words and phrases simultaneously and even use powerful regular expressions to locate and replace 

text that cannot be found using traditional means. 

 

 

Here is what you can do using Multiple Find & Replace tool: 

 Automatically replace all occurrences of words / phrases defined in your list by using Replace All 

button. 
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 Use Microsoft Word’s Find & Replace syntax for simple search and replacement, or use the 

powerful .NET regular expressions to perform complex searches and replacements. 

 Confirm each replacement before it is made by using Find / Replace buttons. 

 Display a list of all occurrences of words / phrases defined in your list using Find All button, and 

then see each occurrence in document context and preview how the text will appear after the 

replacement is made. 

 Decide which found occurrences of words / phrases need to be processed, and use Replace Selected 

button to replace selected occurrences or Format Selected button to apply font formatting or 

highlight color to these occurrences. 

 Search for text that has specific font formatting (including Bold, Italic, Underline style, Font Color, 

Font Size, Subscript and Superscript, Strikethrough and Double Strikethrough, All Caps and Small 

Caps), and apply specific font formatting during replacement or formatting operation. 

 Modify the replacement text of specific occurrences of words / phrases based on context, if the initial 

replacement text must be tweaked. 

 

List of search result which can be used to preview replacements or choose which replacements to make 

Multiple Find & Replace tool is part of TransTools+, a plug-in for Microsoft Word. For more information, 

go to http://www.translatortools.net/products/transtoolsplus/word-multiplefindreplace. 

http://www.translatortools.net/products/transtoolsplus/word-multiplefindreplace
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The latest version can be downloaded from http://www.translatortools.net/downloads 

 

http://www.translatortools.net/downloads#TransToolsPlus

